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Figure 1:  To determine which version of the 
OT you’re using, under the “Help” menu 
select ”About…” and click the “Version” tab.  
This document has been updated for use with 
“User version: Cycle3PhaseII(u1)”. 

http://www.almascience.org


A Users’ Guide to ALMA Scheduling Blocks (SBs)

Introduction
When preparing your ALMA proposal 
(a process often referred to as Phase 
1) with the ALMA Observing Tool (OT), 
you created one or more Science 
Goals (SGs; Figure 2) in which you 
specified the science targets and 
properties, observing frequencies and 
correlator settings, required 
sensitivities, and other observing 
constraints.  These can be viewed by 
clicking the “Proposal” tab (Figure 2).  
After your project was approved, your 
proposal entered Phase 2 (visible 
under the “Program” tab (Figure 3)), in 
which your SGs were used to 
generate Scheduling Blocks (SBs).  
SBs contain all the instructions 
needed by the telescope control 
software to carry out your science and 
calibration observations.  Before your 
SBs can be made available for 
observing, however, you need to verify that the SBs will, indeed, be carrying out the 
observations as you required.  This document provides a quick guide for checking your 
SBs.  Remember, however, that you can always contact your Contact Scientist (CS) 
through the Helpdesk if you have any questions or concerns.
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Figure 2:  The “Proposal” tab shows the Science 
Goals (SGs) exactly as they were generated by you 
when you prepared your proposal. 

Program Tab

Folder Key

Proposal Tab

Figure 3:  The “Program” tab (circled) contains the files generated at Phase 2, including the 
SBs.  Clicking the folder key symbol exposes or hides the contents of the file.  Right-clicking 
the key symbol and selecting “Expand all” allows you to see all the files under that key.



Finding Your SBs
In order to check your SBs, you will need to launch the OT (see Version above), and 
download your project from the archive (File → Open Project → From ALMA Archive).  
Click on the Program Tab (Figure 3).  Here you’ll see a set of nested folders, similar to 
when you created your SGs.  To expand the folders, just click on the key symbols (circle 
with a line segment; Figure 3) or expand them all using right-click → expand all (Figure 3).  
The top level folder is the Project, the second level is the Science Plan, and the third level 
of this hierarchy contains the Science Goals.  So far this is the same structure as you saw 
when generating your proposal.  At Phase 2, a hierarchy of files called Observing Unit 
Sets (OUSs; see Figure 4) is created from each SG, inside of which you’ll find your SBs.  
(For a full description of the OUS hierarchy, see the Technical Handbook, Chapter 8.)

Structure of SBs
Depending on the angular resolution, largest angular structure (LAS), and number of tunings 
specified in the SG, at Phase 2 one or more SBs will be generated for each SG, each in its 
own Member OUS (Figure 4).
The SB can be identified with a yellow clock icon (Figure 4).  Each SB in your project has a 
unique name, with the structure SRCName_a_XX_AR, where ‘SRCName’ is the first (up to) 8 
characters of the representative science target, ‘XX’ is the receiver band used (e.g. 03 for 
Band 3), ‘AR’ distinguishes the array (‘TE’ or ‘TC’ for the 12m-Array, ‘7M’ for the 7m-Array, and 
‘TP’ for the TP-Array), and ‘a’ has the value ‘a’, ‘b’, ‘c’, etc., to give the SB a unique name.
An example of an SB name might be ‘RU_Lupi_b_03_TE’, where ‘RU_Lupi’ comes from the 
first (up to) 8 letters of the representative science source in the SB, ‘b’ means that there is 
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Figure 4:  Each SG 
contains a hierarchy of 
files called an 
Observing Unit Set 
(OUS), which include 
the SBs.  Each SG 
contains one or more 
SBs, depending on 
whether multiple arrays 
and/or multiple tunings 
are required for the 
science goal.



another SB in the project with 
a similar name (i.e. RU 
Lupi_a_03_TE), ’03’ means 
the SB uses the Band 3 
receivers, and ‘_TE’ means 
that this is a 12m Array 
observation.  (If you had 
chosen an angular resolution 
and LAS combination that 
required two 12m Array 
configurations, the SB for the 
second, more compact 
configuration would have 
been labeled ‘_TC’; see 
Figure 4.)
Each SB is made up of three 
sections:  Groups, Targets, 
and Resources (Figure 5).  

Groups

All observing targets that are 
to be executed are included in 
a Group within the SB.  Each 
SB can include multiple 
Groups.  The first, Group 1, 
generally contains the initial 
calibration observations (e.g. 
amplitude, bandpass, 
sideband ratio, etc.), and the 
targets within this Group are 
intended to be done once per 
execution of the SB.  (Note, 
however, that for spectral 
scans, Group 1 is empty.)  The 
second (or subsequent) Group contains the science targets plus relevant calibrators (e.g. phase, 
atmosphere, pointing, etc.) which are repeated until the science integration time is completed.  If 
you click on a group, then the targets associated with that group are highlighted in yellow.

Targets

Targets define all the information needed for an observation, using Resources (see below).  
There is one target for each science source or calibrator.  Clicking on a target causes all of the 
resources associated with that target to be highlighted in yellow (Figure 5).  All of the resource 
parameters for the target are also shown at the same time in the Editor window (Figure 6).  
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Figure 5:  The basic structure of an SB consists of three 
elements:  Groups; Targets; and Resources.
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One of the science targets is labeled with an ‘[R]’.  This target is used as a representative 
target for the SB when the Scheduler is looking for available SBs to observe.  

Resources

Resources define the parameters used for a particular type of observation.  A resource may be 
used by several targets.  Clicking on the resource will highlight the targets making use of it in 
yellow.  It also shows the parameters for that resource in the Editor window.
There are three types of resources (Figure 5):

Field Sources

Field Sources define the position, offsets and radial velocity of each source, including 
calibration sources.  If multiple science sources were defined in the SG, each will have 
its own field source.  Calibration field sources are usually left as a query, to be defined 
at the time of the observation.  Calibration sources, because they tend to be variable, 
are monitored periodically by the observatory.  If there are no suitable calibrators in the 
catalogue, a “cone search” may be carried out prior to observing your SBs.
Instument Setup

The instrument setup defines how the receiver is tuned and the correlator is set up.  
Usually there are two setups:  one for pointing, and one for the science observations, but 
in certain circumstances (e.g. multiple tunings for a spectral scan, multiple sources with 
different redshifts, very narrow total bandwidth) there may be several science setups.  
Observing Parameters

Observing parameters define the sub-scan duration (basic integration time) and the 
total integration time per execution of the SB for each target, as well as other 
parameters.    
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Editor 
Window

Figure 6:  All observing parameters for the SB are viewable in the Editor Window.



Verifying Your SBs
The most common items that need to be verified are the science source positions and 
radial velocities, the instrument setups, and the integration time.  We look at each item 
in turn.

Science Source Positions and Radial Velocity

Each science source has its own Field Source resource (Figure 7), where the source 
position and radial velocity are defined.  Clicking on the Field Source (e.g. in Figure 7, 
the Field Source for RU Lupi) shows the parameters in the Editor window to the right.  
Where a mosaic or offsets have been specified, you may need to scroll down the Editor 
window to see them (Figure 8).  Total Power (_TP) science observations require a 
reference position, which your Contact Scientist may have requested you to provide.  
That can be checked by scrolling down the Editor window.
On the top left corner of the Editor window (Figure 9), if you click on the Spatial tab you 
can get a graphical view of the source position, offsets and mosaic positions.  This view 
works the same way as when you generated your SGs in Phase 1.  

Instrument Setup

Because of the power and flexibility of the ALMA correlator, the Instrument Setup resources are 
much more complex than the other resources, and checking them can be daunting.  However, in 
most cases only a few numbers are relevant and can be checked quickly.   
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Figure 7:  The Field Source resource, showing the position, radial velocity and velocity frame, 
proper motion, and other properties.



Click on the Science Instrument Setup resource (see Figure 5).  The targets using this setup are 
highlighted in yellow.  Scrolling down the Editor window, near the bottom you’ll see (up to) four 
tabs, one for each baseband (BB_1, BB_2, etc.; Figure 10).  Click on each baseband tab in turn.  
At the bottom of each baseband window is another set of 1-4 tabs, one for each spectral window 
(SW-1, SW-2, etc.; Figure 10).  Click on each of these tabs in turn to check the center frequency 
of the spectral window (rest and sky), the bandwidth, averaging factor, and spectral resolution 
(after smoothing and averaging).
If you have multiple SBs within an SG (Figure 3) due to multiple array configurations, then all of 
the 12-m and 7-m Array SBs (_TE, _TC, _7m) and the science TP-Array SB (e.g. 
RULupi_a_03_TP), should all have identical science instrument setups.  The TP-Array 
calibration SB (CalSourceName_xxx_TP) may have a different instrument setup from the others.
(Note that the Desired Center Freq listed near the top of the BB window (Figure 10) may be 
different from the center frequency of the spectral window.  This is because the former is the 
centre frequency of the 2 GHz wide baseband, whereas the spectral window can be anywhere 
in the baseband.  See Figure 11.)     
On the top left corner of the Editor window, if you click on the Spectral tab you can get a 
graphical view of the correlator setup (Figure 11).  This view is similar to the Spectral 
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Spatial tab

Figure 9:  The Spatial tab 
shows a graphical 
presentation of source 
positions and offsets.  A 
background image must be 
loaded from an online server 
or using a local fits file.

Figure 8:  Offset positions (e.g. for a mosaic) are found by scrolling to the bottom of the Editor 
window in the Field Source resource.



view when you generated 
your SGs in Phase 1, 
except that now both the 
baseband location and 
width as well as all 
spectral window widths 
are shown graphically.
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Figure 10:  Click on the Science Instrument Setup and scroll to the bottom of the Editor 
window in order to check your correlator setup.  Each baseband (BB) has its own tab, and 
each spectral window (SW), if more than one within the baseband, has its own tab.  Click on 
each in turn to check the setup for each spectral window in each baseband.

Figure 11: A graphical 
view of the correlator 
setup using the Spectral 
tab, showing the ranges 
for each baseband as well 
as the bandwidth and 
range of each spectral 
window.

Spectral tab



Integration Time

Click on the Science 
Observing Parameter resource (Figure 5).  The 
target(s) using this setup will be highlighted in 
yellow.  In the Editor window (Figure 12) you can 
check the Integration Time on Source, which is 
the total integration time (per execution of the SB) 
for each target using this resource (Figure 12).  
(For targets with multiple offsets, e.g. mosaics, the 
integration time per point will be the integration 
time on source divided by the number of offsets.)  
The integration time on source is limited so that 
the SB will be completed in approximately 2 hours 
or less including all calibration observations, so it 
will often be shorter than the total integration time 
required.  In this case, the SB may need to be 
executed multiple times.  Click on the SB icon 
(yellow clock) and scroll down to Execution Count 
(Figure 13).  The overall total integration time on 
source is then the execution count multiplied by 
the integration time on source.
Note that if more than one array configuration is required for your SG (e.g. a second, more 
compact 12m-Array configuration, and/or the ACA, etc.), then the integration time for the 
more compact configuration(s) will be governed by the required integration time for the most 
extended configuration (i.e. the SB with the ‘_TE’ at the end of its name).  For Cycle 3, the 
integration time for the compact 12m-Array configurations (‘_TC’) will have half the total 
integration time on source as the extended configuration SB (‘_TE’); the 7m-Array and TP-
Array SBs have a more complicated formula for determining the total integration time. 
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Figure 12:  The Science Observing 
Parameter resource shows, among other 
things, the total integration time on source 
per execution of the SB.

Figure 13:  Click on the SB name (yellow clock icon) and scroll down the Editor window to find 
the Execution Count.  The total time on source will be the Integration Time on Source (Figure 
12) multiplied by the Execution Count.

Execution Count

Total Integration 
time on-source 
per execution



Array Configuration

Currently the ALMA observing software uses the values of angular resolution and LAS 
stored in the Control and Performance section of the SG to determine which array 
configurations are suitable for observing your SBs.  To confirm which array 
configurations are likely to be used for your SBs, consult with your Contact Scientist 
through the ALMA Helpdesk.

Other Considerations

For other observing constraints, such as time constraints, observing cadences, 7m-
Array and TP-array setups, etc., consult with your Contact Scientist through the ALMA 
Helpdesk.  

What Next
Once you’ve checked your SBs you will need to communicate with your Contact 
Scientist whether:

a) everything is fine and you approve the SBs as-is;  or
b) you’ve encountered a problem, e.g. source position error, wrong bandwidth in a 

spectral window, etc.

Everything is Fine

You’ve checked everything in your SBs and there are no errors or inconsistencies.  You 
will still need to communicate with your Contact Scientist using the ALMA Helpdesk that 
you approve your SBs.  The CS will then have the SBs marked as Ready to Observe in 
the Project Tracker (PT).  You can check the status of your SBs using the PT, which 
you’ll find on the ALMA Science Portal (almascience.org) under the Observing menu.  
You can also enable the PT to send you notices automatically whenever the status of 
your SBs changes (e.g. when observations are taken).

Problem in the SBs

If you’ve found any errors in the source positions, velocity, correlator settings, etc., or if 
you have better information on these parameters than you had when you first submitted 
the proposal, then you should communicate these to your Contact Scientist through the 
Helpdesk.  Small corrections or updates to source positions or velocities may be 
considered as “minor” changes, and if agreed by the CS, may be applied to the SBs.  
Once the changes have been made, you should again check your SBs and let your CS 
know whether or not you approve them
Significant changes to source positions, velocities or correlator settings, or changes 
which would result in an increase in observing time, may be classed as “major” 
changes, and your CS will let you know if this is the case.  Major change requests must 
be submitted through the Helpdesk and are reviewed by a committee at the JAO with a 
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final decision by the ALMA Director.  While the request is being processed, all 
observations for your project are suspended until a decision is made.  Major changes 
are approved only in very exceptional cases.  See the ALMA Proposer’s Guide, 
Appendix D.2 for an explanation of the policy on changes to submitted projects.

Appendix A - Acronyms used

ACA - Compact array, including 7m Array and TP Array
ALMA - Atacama Large Millimeter/Submillimeter Array
BB - baseband
CS - Contact Scientist
FDM - correlator spectral mode
JAO - Joint ALMA Observatory
LAS - Largest Angular Structure
OT - ALMA Observing Tool
PT - Project Tracker
SG - Science Goal
SB - Scheduling Block
spw - spectral window
TDM - correlator continuum mode 
TP Array - total power array, part of ACA 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The  Atacama  Large  Millimeter/submillimeter  Array  (ALMA),  an 
international  astronomy  facility,  is  a  partnership  of  the  European 
Organization for Astronomical Research in the Southern Hemisphere 
(ESO), the U.S. National Science Foundation (NSF) and the National 
Institutes of Natural Sciences (NINS) of Japan in cooperation with the 
Republic of Chile. ALMA is funded by ESO on behalf of its Member 
States, by NSF in cooperation with the National Research Council of 
Canada (NRC) and the National Science Council of Taiwan (NSC) and 
by NINS in cooperation with the Academia Sinica (AS) in Taiwan and 
the Korea Astronomy and Space Science Institute (KASI).

ALMA construction and operations are  led by ESO on behalf  of  its 
Member  States;  by  the  National  Radio  Astronomy  Observatory 
(NRAO), managed by Associated Universities, Inc. (AUI), on behalf of 
North  America;  and  by  the  National  Astronomical  Observatory  of 
Japan (NAOJ)  on behalf  of  East  Asia.  The Joint  ALMA Observatory 
(JAO)  provides  the  unified  leadership  and  management  of  the 
construction, commissioning and operation of ALMA.


